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ZoomWare 1.0
by Wallace L. Pensgen

Rochester Computer Society, Inc., Rochester, NY

An Electronic Magnifying Glass 

Z
oomWare 1.0 is a new product by Ai Squared,

a firm with 20 years experience in developing

computer access solutions. This software will

benefit anyone in need of some eyesight assistance

when using a monitor. It will be especially useful on

the small screen of a laptop or notebook computer. 

It is available for purchase via download or on a

CD, which I used. System requirements are XP with

1 GHz Pentium 4 equivalent or VISA with 1.5 GHz.

The usual minimum RAM,

512 MB and 1GB re-

spectively, is needed. 

The main capability is

magnification of the screen.

This is available in four .25

steps up to 2x original size.

Enlargement ma”y include

the full screen area, or a

rectangle 1/4 1/16 of full

size. This partial viewing

area is movable over any

portion of the screen. An-
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other feature is the ability to invert the screen to

white text on a black background.

Alternatively, the screen color may be chosen

from a palette of 7 colors in 4 tints. Finally, pointer

and cursor enhancement are available. You may

vary the size and color of a pointer. I-beam cursor

visibility may be enhanced by the addition of small

triangles on top and below Installation is straight-

forward and places an icon on the desktop.

When called up, the User Interface appears with

7 convenient buttons for choosing options. These

include selection of magnification (also full or partial

screen), color and size of pointer as well as cursor

modifications. Default enlargement is the maximum

2x but it and other parameters are selectable and

may be locked. 

The interface has a large on/off button and a

useful Menu option. A nice feature for users is the

popup description of the function when the cursor is

placed on a button. The Menu choices include

saving, and restoring settings, comprehensive help,

product registration, updating and the ability to

view the computer’s system data. 

A very useful feature is the Option selection on

this Menu button. Among several choices, I found

the Hotkeys, 8 “Standard” and 12 “Advanced,” to be

significant time savers. These could be user modi-

fied. I installed it on my desktop with the Windows

XP Home operating system. Although unobtrusive it

was readily available when needed. 

It was useful for screens with small print as

found with some e-mail and internet sites. I also

found it an aid for viewing detail on photos from

map sites. The product was well designed and

included several opportunities to customize. The

user needs some practice to take advantage of all the

capabilities. 

The price to download it is listed as $149 while

the quoted CD cost is $175. I found this software to

be a valuable addition to my computer’s capabilities

and expect to continue taking advantage of it. 

Broadsides
by Ron Broadhurst

Space Coast PC Users Group, Inc., FL

T
hese ideas are compiled from years of accumu-

lations from various magazines, books, on-line

sites, and my own personal experience. I claim

neither originality nor ownership to any of its

contents. My only intent is to share the various

“tips,” “tricks,” & “hints” in hopes of helping &

maybe enhancing your computing experiences. They

are all intended for anyone who uses a PC. It is for

beginners as well as advanced users. Enjoy and use

as you will.

Q: I accidentally deleted my recycle bin in

Vista, how do I get it back?
Go to Control Panel and click on the Personaliza-

tion options: 

Click Change desktop icons and you’ll get this

handy little dialog box: Click the Recycle Bin check-

box as highlighted above, click OK, and your Recycle

Bin should reappear on the desktop.

How to Get Rid of “Send Error 

Report to Microsoft”
Right click My Computer on the desktop or in the

Start menu.

Click Properties.

Click the Advanced tab.

Click the Error Reporting button at the bottom.

Click Disable error reporting. You can select the

checkbox under it if you still want to be notified

when errors occur.

Click OK.

Note that you can disable error reporting for the

operating system only, or for programs only, by

unchecking the appropriate box under the Enable

error reporting option.

You can also configure error reporting only for

specific programs by clicking the Choose Programs

button.

Alphabetize Start Menu Listings
When you install a new program on your system,

it will often appear at the end of your Start menu.

Reorganizing files alphabetically in the All Pro-

grams menu does not affect how they appear in your

start menu. In order to alphabetize your start menu,

you’ll want to click Start and select All Programs.

On any file or folder right-click and then select Sort

By Name. Now all of your Start menu programs are

in alphabetical Order. You Can Also Sort Subfolders

in Your Start Menu the Same Way.

Make Your Quick Launch Icons Bigger
Unlock the Toolbar

Right click the QL toolbar

Select the View tab

Select large icons

Pin an Application to Start Menu
The Windows XP Start menu includes an area

where two or more Microsoft applications, usually

Internet Explorer and Outlook Express, are perma-

nently positioned for easy access. You can add your

favorite application to this same convenient location.
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Open Windows Explorer and locate the executable

file for the application. Right-click the file and select

Pin To Start Menu. The application will now appear

in the Start menu. To remove an application, locate

it, right-click it, and select Unpin From Start Menu.

Alternatively, you can right-click the app in the

Start menu and click Unpin From Start Menu.

Change System Sounds
Through the Control Panel you can change your

system’s program event sounds. Click Start and

Control Panel. If you’re using Category View, click

Sounds, Speech, and Audio Devices; and Sounds and

Audio Devices. If you are using the Classic View,

click Sounds and Audio Devices. This loads the

Sounds and Audio Devices Properties dialog box.

Choose the Sounds tab. Select the sound you’d like

to change in the Program events box, and then select

a new sound from the Sounds drop-down menu. Or

select a sound you’ve saved to the hard drive by

using the Browse button to navigate to the sound

file. Change as many sounds as you like. Save your

changes as a sort of theme from the Sound Scheme

drop-down menu above the Program events box.

(Select the blank line and click Save As.) You can

also choose to disable program event sounds. When

you’re finished click OK.

Saving E-mail Messages
To save e-mail messages highlight the message

you want to save, then click on File -Save As. Select

where you want to save the message and then save

it as a txt file.

Printing e-mail addresses in outlook express
To print your e-mail addresses:

Print each name and address on one line:

Open Outlook Express click on File, Export,

Address Book, Select Text File (Comma Separated

Values) and click the Export button.

Name the file, click Browse button to save in Desk-

top. and at the bottom line, SAVE it in Text File (*

.txt), click

Next, Deselect everything except NAME and E-

mail Address then click Finish. Click on the Text

File and Print it.

Outlook Express Address Book Back-up
From Outlook Express, click on Tools/ Address

Book, then File / Export / Address Book

Choose a storage location and give it a file name.

Click save E-mail Shortcut / right click on the

Desktop and choose New then Shortcut.

In the Command line type mailto:yourfriend@

whatever.whatever. For example-mailto:yourfriend

@cfl.rr .com then click Finish and you have a short-

cut to your e-mail friend. Double click and your e-

mail opens up ready to go.

Control Panel Shortcuts
If you’re tired of multiple clicks to get to your

floppy drive, CD-rom drive, D-drive, E-drive or to

the Control Panel, you can put a shortcut on your

desktop for instant access.

Open MyComputer, right click on the icon for your

floppy drive, CD-rom drive, E or D-drive or whatever

you want and then select “Create Shortcut.” This

will place an icon on your desktop for instant access

to what you chose.

You can use this technique for any Folder you

access frequently by putting the shortcut on your

desktop. Now, your desktop becomes your operations

center with quick access to any application, folder,

or file on your PC.

Shortcut for Shortcut
You can assign a Keyboard key combination to

any Shortcut. If you right click on any shortcut icon

and choose Properties, you can then type Ctrl+any

letter to assign the key combination that will open

your Program. It should be a unique key and some-

thing you will remember. e.g. S for solitaire. This

would be of great help if you wanted to go to another

program when you cannot see your Desktop.
This article has been obtained from APCUG with the

author’s permission for publication by APCUG member groups;
all other uses require the permission of the author (ringram728
(at) earthlink.net).

Advanced WindowsCare Personal

Edition FREEWARE
by Ira Wilsker 

A
lot can go wrong with the software and oper-

ating systems on our computer. Just like a

car, if maintenance is ignored or infrequently

performed on Windows,

problems can occur that

can impair the execution of

software on our computers.

To help us perform the soft-

ware maintenance on our

computers, a small soft-

ware company IOBIT has

released a freeware version

of its Windows repair util-

ity, Advanced Window-

sCare Personal Edition. For

those concerned about the safety and security of free

software, this product is free of any spyware or
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adware. 

Available for free download from the publisher’s

site, www.iobit.com. or the alternative popular mega

sites including download .com, and tucows.com,

Advanced WindowsCare Personal Edition is a

comprehensive suite of utilities that can identify and

repair many of the common system problems that

plague Windows users. Advanced WindowsCare will

run on Windows 2000, XP, and Vista. For those who

may desire an even more powerful and sophisticated

suite, IOBIT also has an upgrade available, Ad-

vanced WindowsCare Professional, which sells for

$29.95 (15 day free trial available). The free Per-

sonal Edition has been very successful, with over

four million downloads, including over two million

from download.com alone. C-Net, the owner of

download.com, calls this software, the “#1 most

popular system utility in download.com”, where it

has received a five star rating. Tucows has given

this software a “five cows” rating, while ZO Net has

awarded it five stars, as well as given it its coveted

“Editors’ Pick” award. Softpedia, another well

known resource, rates Advanced WindowsCare

Personal “Very Good”, and gives it a four star rating.

Obviously, this appears to be some good software

that can make a valuable addition to anyone’s

software collection. 

Advanced WindowsCare Personal Edition is very

easy to use, and offers a “1 click” option where all of

the major utilities are automatically run, which

subsequently gives a detailed report to the user, and

offers the options to either automatically or selec-

tively repair any problems found. Personal Edition

is also very fast, with most scans being completed in

about one minute. 

One useful feature of this software is a spyware

scan that searches the computer for spyware and

adware, using periodically updated signature files.

Any such malware that is found can be selectively

deleted by the software. For users concerned with

privacy, the software can also erase all history files

on the hard drive.  

The registry is a complex database containing

information on all of the software and hardware

installed in the computer. Often the registry be-

comes bloated with obsolete information, and cor-

rupted data, which can create a serious performance

drag on the computer. Good PC hygiene dictates

that the registry should be periodically scanned for

errors and cleaned, and this software does an excel-

lent job of this. One nice feature is the ability to

recover any changes made with an integral restore

feature. As a demonstration of its capabilities, as a

test, I purposely ran other registry cleaning and

repair utilities prior to running this one. As an extra

precaution, I used my Windows system restore

feature to back up my critical files prior to the test.

I ran three’ of the other registry repair utilities, and

dozens of registry defects were identified and re-

paired; I then ran Advanced WindowsCare Personal

Edition, and hundreds of additional registry errors

were found and repaired, that the other programs

missed. There was no need to restore my files,

because the system ran very well after the serial

repair. This software is capable by itself to repair

the registry, and the other registry repair utilities

are no longer needed; this software did it all. 

Our hard drives become cluttered with a variety

of junk files, such as obsolete cache and temporary

files. These useless files may waste countless mega-

bytes on our drives, and slow down the ability of the

hard drive to find data. If useless data is deleted

from the hard drives, computer performance can be

enhanced. Advanced WindowsCare Personal Edition

contains a very efficient junk file removing utility.

As a matter of personal choice, I prefer to look over

the list of files found and decide which to delete, but

it is fairly safe to delete what the software finds. As

a matter of practice, after useless files are deleted,

it would be a good idea to run Windows integral

defragmentation utility, or a third party disk

defragmentation utility, to further improve hard

drive performance. 

Another feature built into the software gauges

Windows and internet performance, and offers

options to improve the speed of the system. This

helps give us the performance that we paid for when

we originally purchased our systems, and helps to

maximize our internet throughput. 

As our computers age, we are often plagued with

slow startup and shutdown problems. This occurs

because as we install software on our computers,

many of the programs place items in the system

startup by default, which forces the software to load

when the computer is booted; more items in the

startup means slower and longer boot times. Ad-

vanced WindowsCare Personal Edition contains a

powerful but simple startup manager which displays

the contents of our startup, and allows for the easy

management and control of what loads when we

boot. Fewer items loaded at boot means that our

computer comes up faster, and runs faster because

there is less demand on system resources. Because

there are fewer items running, shut downs are also
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faster. 

I have used this software for about a month and

found it very useful and reliable, and can recom-

mend it to all PC users with Windows 2000, XP, or

Vista. 

One of the most frequent questions asked on my

weekly radio show on KLVI is how to improve

computer performance and speed. Advanced

WindowsCare Personal Edition is a valuable free

tool that does much to improve performance, clean

up the registry and startup, delete useless files, and

otherwise provide benefits to the user. 

Websites: 

http://www.iobit.com 

http://www.iobit.com/advancedwindowscareper.html

Media Notes
by Bill Petitt

Southeast Virginia Computer Group, VA

A
new year, a new president, a new cabinet and

the same old woes. Hopefully, we’ll get this

worked out soon. Intel’s new processor series

and motherboard chipsets are on the market and

promise excellent performance for the dollar. Slowly,

the board manufacturers are populating the shelves

with their new offerings so I’ll be starting the

research and purchasing for my newest machine.

Can’t wait.

USB 3.0 Spec Finished: It’s SuperSpeed USB
With USB 2.0 ports becoming a common as

dirt—you’ll find them in everything from mobile

phones to DVD players these days—you know the

time has come to move on to a new version. And

that’s just what the USB 3.0 Promoter Group an-

nounced recently.

USB 3.0 will support data rates as high as 5.0

Gb/sec—rendering the new standard 10 times faster

than USB 2.0. Having already dubbed USB 2.0 as

“Hi Speed USB,” however, the group had to come up

with a brand-new superlative for USB 3.0. After

much discussion, they finally settled on “SuperSpeed

USB” (perhaps holding “Ludicrous Speed” in reserve

for USB 4.0).

“SuperSpeed USB is the next advancement in

ubiquitous technology,” said Jeff Ravencraft, USB-IF

president and chairman. “Today’s consumers are

using rich media and large digital files that need to

be easily and quickly transferred from PCs to de-

vices and vice versa. SuperSpeed USB meets the

needs of everyone from the tech-savvy executive to

the average home user.”

Although USB 3.0 will use a different cable, it

will use the same types as connectors and will

therefore be backward-compatible (good thing,

considering that more than two billion USB devices

were shipped in 2006 alone, according to the USB

Implementers Forum). Six signals will be carried on

a USB 3.0 cable (four for a SuperSpeed data path

and two for a non-SuperSpeed data path). USB 2.0

cables carry just two signals for low-speed (1.5Mb/s)

and full- and high-speed data paths (12- and

480Mb/s, respectively). The USB 3.0 bus will provide

50 percent more power for unconfigured or sus-

pended devices, and 80 percent more power for

configured devices.

The USB 3.0 Promoter Group anticipates that

SuperSpeed USB discrete controllers will hit the

market in the second half 2009, with the first

consumer products appearing in 2010. The group

expects that data storage devices such as flash

drives, external hard drives, digital cameras and

camcorders, and digital media players will be among

the earliest USB 3.0 products.

First Camcorders, Now Webcams: HD Gets

Cheap
High-definition is rapidly going mainstream.

Samsung has announced a new image sensor for

notebook webcams that supports 720p HD video at

30 frames per second.

It’s too early to say how much HD-ready web-

cams will add to the cost of portable PCs, but given

the sour economy and pricing pressures in the

laptop market, it probably won’t be a lot. Mass

production of the S5K4AW CMOS image sensor is

slated to begin in the first half of 2009.

The Samsung announcement is another indica-

tion of how fast HD technology is going mainstream.

In fact, it’s getting downright cheap. Bargain HD

camcorders like the Flip MinoHD ($230) and the

Kodak Ai6($180) are pocket-sized consumer gadgets

that shoot 720p video. Trends indicate that most

consumer video gadgets will soon be high-def. It

won’t be long before the terms HD and high- defini-

tion sound as quaint as stereophonic and high

fidelity.

But are we really ready for an all-HD world? The

Samsung sensor, for instance, can improve image

quality in low-light conditions, such as those late-

night webcam sessions. And HD camcorders will

likely capture more pimples, wrinkles, and gray

hairs than most of us would care to save for poster-

ity.

Maybe there’s something to be said for grainy,

low-res video.
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Vista SP2: Six Things You Need to Know
Windows Vista Service Pack was released as a

public beta version Thursday, Nov. 27th, Microsoft

confirmed. The program, which has been under

limited testing since October, will become available

on the Microsoft TechNet site. Here’s what you need

to know before making the upgrade.

Vista Service Pack 2 isn’t for everyone.
SP2 beta is, as the name suggests, a product still

under development. Microsoft is recommending only

“technology enthusiasts, developers, and IT pros”

willing to test the software take on the upgrade.

General users are advised to wait until the final

release, which is set for the first half of 2009. Unoffi-

cial reports indicate it is being targeted for an April

completion.

SP2 is a fairly significant upgrade.

Windows Vista SP2 includes numerous changes

to the Vista operating system. Here are some of the

highlights of what it’ll do for you:

• Let you record data onto Blu-ray discs

• Add into your system Vista Feature Pack For

Wireless, which provides support for the latest

Bluetooth technology—Bluetooth v2.1—as well as

for the Windows Connect Now (WCN) Wi-Fi protocol

• Give you better Wi-Fi performance when you’re

exiting Vista’s sleep mode

• Make your RSS feeds sidebar gadget work

faster and better

• Give you the latest desktop search engine,

Windows Search 4

• Cut down the resources it takes to run your

various sidebar gadgets

It’ll give your OS an overall tune-up, too.

Vista Service Pack 2 will also deliver some

hidden improvements, which will:

• Give your computer support for VIA Technolo-

gies’ new 64-bit CPU

• Let your system support exFAT, which can

handle larger files and can also use UTC time-

stamps so you can synchronize files across different

time zones

• Boost your power management efficiency by as

much as 10 percent

Additionally, a slew of system bugs will be

corrected in the update, including some slow shut-

down problems and other crash-causing issues.

You have to have SP1 installed before you begin.

Like most Microsoft Service Packs, SP2 won’t

work on your system if you haven’t already installed

SP1. If you’re thinking about trying the SP2 up-

grade, you’ll have to hit SP1 first.

Things may not be totally smooth at first.

Microsoft has had a sketchy history with glitches

seemingly caused by its Windows Service Pack

updates. It sometimes takes several hotfixes for

these kinks to be worked out. That’s precisely why

it’s often best to wait for the full release, at the very

least, before jumping on the upgrade.

This Service Pack does offer some improvements

over past ones.

Microsoft did take some steps to make this

Service Pack function a bit better than past up-

grades. It is the first Windows Service Pack to work

for both the client (Vista) and server (Windows

2008) editions of the operating system in a single

update.

SP2 also includes what Microsoft is calling a

“Service Pack Clean-up Tool.” This will permanently

delete old versions of files SP2 is updating, helping

you reduce clutter and get rid of outdated system

files that’d otherwise just take up space.

Windows 7 Beta 1 to arrive January 13?
At the Professional Developers Conference in late

October, Windows chief Steven Sinofsky announced

that Windows 7 Beta 1 would be ready “early next

year.” A Microsoft insider has now confirmed the

actual date, which is indeed very early next year. In

a comment on his blog, Keith Combs has revealed

that Windows 7 Beta 1 will be available on or

around January 13, 2009.

Keith’s post links to a promotional announcement

for the MSDN Developer Conference series, where

every registrant will receive a DVD. The first event

in the MSDN series is in early December, in Hous-

ton. So does that mean the next Windows 7 beta will

be ready for public distribution this month? Accord-

ing to Keith, not just then:

My understanding is that the DVD will not be

ready for the first few show dates but will be mailed

to each attendee. 

Microsoft is targeting to have the DVD’s in the

materials from 1/13/2009 on.

So I would imagine the folks attending the

Houston, Orlando and Atlanta shows this month

will receive their DVD’s around mid January as

well. That’s an assumption on my part. Could be

earlier or later, but they will get them.

Reading between the lines, I’ll predict publicly

what I’ve been saying privately for the last month or

so: Windows 7 Beta 1 will be publicly unveiled at

CES. Microsoft CEO Steve Ballmer is giving the

pre-CES keynote address on January 7, 2009, the

night before the show opens (Bill Gates has had this
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time slot for the past few years). There is absolutely

no doubt in my mind that Ballmer will be showing

off Windows 7 at CES. It’s reasonable to assume

that Microsoft will provide an early update to key

media sources, including reviewers who attended

the Microsoft-sponsored workshop at PDC in Octo-

ber.

Any public release would come only after that

first demo, which makes the January 13 date a

nearly perfect fit for public availability.

Hands-on with Netflix streaming on TiVo
At the end of October, Netflix and Tivo an-

nounced that Netflix’s streaming service would be

coming to TiVo DVRs by the end of 2008. The com-

panies have made good on their promise, and the

s e r v i c e  ha s

rolled out to the

latest series of

Tivo’s. I had the

chance to give it

a full workout.

The short story:

this is an awe-

some added fea-

ture for TiVo

HD owners.

The interface

is significantly

different than

what I’ve seen

on the Netflix

viewer by Roku.

Rather than offering up large box shots to scroll

through, the TiVo’s interface instead lists the names

in text, with smaller box shots showing up on the

right side. I preferred the TiVo’s interface, as it

allows me to see more titles at once, which is conve-

nient if you have a large queue. On the other hand,

I felt the TiVo interface was less responsive, which

is a problem that affects almost all of the extra

services on TiVo.

While the interface is an improvement over the

Netflix Player, I still saw plenty of room for im-

provement. Now that Netflix has added a lot of

content to the Instant Streaming service, my instant

queue is getting pretty full. The current interface

simply lists titles in the same order as your Instant

Queue, which, if you’re anything like me, is kind of

haphazard. While the queue system makes sense for

the traditional Netflix mailing service, I’d rather

have more categorization options--s uch as by genre

and star rating--for online streaming. I was also

disappointed that there was no way to tell from the

TiVo screen which movies were available in “HD”

quality.

Like on the Netflix Roku Player, video quality is

determined by the speed of your connection. While

the Netflix Player uses a “four dot” graphic to

indicate video quality, the TiVo HD has a more

granular meter, with about 14 bars. I generally got

all 14 bars filled up, using a wired Ethernet connec-

tion and a standard cable modem.

Although the term “near-DVD” is often abused

with video-streaming services, it accurately de-

scribes the video quality offered by Netflix stream-

ing on TiVo. I fired up a bunch of movies and I was

never disappointed by how they looked. Pan’s

Labyrinth was available in “HD” and in most cases

it looked as good as a well-mastered DVD-- occasion-

ally I could see some blockiness to the image or the

background would be soft, but nothing to take me

out of the movie-watching experience. Next up was

Ratatouille, which wasn’t available in HD. This

looked slightly softer than DVD-quality (and much

softer than the excellent Blu-ray), but not by much.

Only the pickiest videophiles would turn up their

noses at the image quality. In short, there’s room for

improvement, but it’s darn good already. (You can

read more about the technical details behind

Netflix’s streaming service here:

http://news.cnet.com/8301-17938_105-10102284-1

.html.)

I did notice some artifacts on the audio side,

although it was mostly subtle. I really only noticed

it on one movie, but I could hear some soft pops,

similar to what you might hear on streaming Web

video when it’s not fully buffered. And, like all

Netflix Instant Streaming content, you’re limited to

stereo audio rather than surround. I’m really hoping

Netflix adds surround soundtracks in the near

future.

The most important takeaway for us is that I

watched several movies without any hiccups and

each movie started up in a few seconds. While many

streaming services “feel” like you’re streaming video

over the Internet, this feels more like you’re expand-

ing the recorded content of your TiVo. And while you

lose some of the benefits of watching the actual DVD

(special features, surround sound), I couldn’t help

but notice that in some ways it’s better than DVD;

movies loaded right away and with no previews.

If you already have TiVo and Netflix, there’s no

reason not to take advantage of this feature. If

you’re choosing between a TiVo and a standard cable
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/satellite box, this is definitely a feature to take into

consideration, although also be aware that Netflix

streaming is available on many other devices, such

as the X-Box 360, Netflix Player, LG BD 300 and

Samsung BD-P2550--and I expect it to be even more

ubiquitous in 2009. While the hardest part about

going with a TiVo over the standard options is the

monthly fee, added features like Netflix, Rhapsody,

and Amazon Video on Demand make it a lot easier

to swallow.
From the January 2009 issue of The Umbrella Online, The

Monthly Journal of the Hampton Roads (VA) Computing
Community.

Q. I replaced my old printer with a new one. Now,

when I try to print, my computer still thinks the old

printer is the one to use. My new printer was in-

stalled properly and I can see it listed, but how do I

make sure that is the printer my computer uses?

A. You need to tell your computer which printer is

your default, meaning the printer it should use

whenever it receives a print command. To do this,

click Start Settings Printers. You’ll see your old and

new printer icons displayed. Right-click the printer

that you want to establish as your default printer,

which in this case is your new printer.

On the menu that appears, click to place a check

mark next to Set Printer as Default, then close the

Printers window. Your new printer will spring to life

the next time you have something to print.

Q. I bought a new keyboard that I’m not used to, so

I keep hitting the Caps Lock key accidentally. I

know there is a way to make the computer beep

when I do that, but I can’‘t remember how that’‘s

done. Can you help, Mr. M?

A. The ToggleKeys feature is what you’‘re looking for

and you can find it by going to Control Panel Acces-

sibility Options. On the Keyboard tab, place a check

mark beside Use ToggleKeys. Windows will emit a

high-pitched sound when the Caps Lock is enabled,

which is not unlike the sound I make when I dis-

cover that I’ve BEEN TYPING IN ALL CAPS. It will

emit a lower-pitched beep when it is turned off. The

same holds true for the Num Lock and Scroll Lock

keys, though nobody ever uses the Scroll Lock key.

If you’re using Windows Vista, go to your Control

Panel, then click Ease of Access Make the Keyboard

Easier to Use. Place a check mark beside Turn on

ToggleKeys. 

Q. Sometimes when I’m trying to install software, I

get a message that tells me to disable my anti-virus

protection first. Following your recommendation, I’m

using the free Moon Secure (Beta) (http://tinyurl

.com/5n2fs7) anti-virus, but I can’t figure out how to

temporarily disable it. I love your newsletter. I

always learn something new.

A. You can temporarily disable any anti-virus

program by right-clicking its little icon in the Sys-

tem Tray, located in the lower right-hand corner of

your screen. From the menu that appears, click Exit

or Quit. Other programs may use the word Close or

Stop or Disable, but the ‘net effect is the same. 

There may be an additional prompt that asks you

to confirm your action. When the anti-virus icon

disappears from the System Tray, your anti-virus

program is disabled. You can start it again via Start

Programs and launch it manually, or restart your

computer to reactivate it. 

Mr. Modem’s DME (Don’t Miss ‘Em) Sites of

the Month

Musicovery: Mood Radio
A novel, interactive site that plays music based on the

mood of the user. Click the site’s graphical iPod-like console

that features two mood scales that range from "Energetic" to

"Calm" vertically, and "Dark" to "Positive" horizontally. No

"Surly" or "Hostile," so I was out of luck. Click to include or

exclude specific genres of music, plot a point along the

timeline from the 1950s to the 2000s, then sit back and

listen. Hint: There is nothing like a snappy, toe-tapping

Gregorian chant to brighten up one’s day.

www.musicovery.com

Vaudeville! 
Vaudeville represents the true beginning of popular

American entertainment, long before Britney came along

and ruined everything. Don’t believe the vicious rumors that

vaudeville is dead; it can still entertain you on the virtual

stage today, thanks to this tribute site. Here you can read

about the amazing acts, savvy showmen, bold entrepreneurs,

and the entire history of the vaudeville movement. If you

prefer, sit back, relax, and listen to recordings of sketches

and songs, or watch videos of vintage acts. Historical

minutia: The word "vaudeville" comes from the French

Chanson du vau de Vire or "Song of the Vale of Vire," a

valley near Calvados, France, noted for satirical folk songs.

(I’‘ll bet you didn’t know this was going to be so educa-

tional. I apologize. It won’t happen again.)

http://tinyurl.com/3xd74y

Viral Video Chart
N o  n e e d  t o  s e a r c h  G o o g l e  V i d e o

(http://video.google.com) and YouTube (www.youtube.com)
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for the best videos, when you can view the cream of the

video crop from one location. Think of this as a digital-age

version of the "Top 20 Countdown," a daily listing of the top

20 Internet videos. www.viralvideochart .com

For plain-English answers to your questions by e-mail,

plus great computing tips, subscribe to Mr. Modem’s

award-winning newsletter. Subscribe using Promo Code

1146 and receive one free month with your six-month

subscription (28 issues!) To view a sample issue or sub-

scribe, visit www.MrModem.com.

FOSS Flap
by Stew Bottorf

Tampa Bay Computer Society

I
n this issue I’m outlining steps to build an online

website for less than $25 a year. Put your group

online or show-off family photos inexpensively.

To do this we need to accomplish three tasks:

1. Get software to build the website;

2. register an online domain;

3. purchase a web hosting service. 

Software:
Kompozer (kompozer.net/)

is the successor to the handy

NVU editor. NVU is no longer

being updated, and the

KompoZer folks have added

some bells and whistles to the

solid Mozilla / NVU HTML

editor. Make a new folder on

your computer desktop, name

it My WebSite, and store all your pages there prior

to upload (this makes a local backup of your online

website). I also make an “images” subdirectory

inside this folder to keep things neat. KompoZer is

easy to navigate, but if you have questions, check

out this helpful site: www.thesitewizard .com /get-

ting started/kompozer-tutorial-1 .shtml. KompoZer

is open source software, it’s free, and versions exist

for Windows, Mac, and Linux. Be sure your home

page is saved as index.html or index.htm.

Domain Registration:
What will you

name your site?

It’s hard finding

names not already

registered, but that

is your task. Try

your own name,

but avoid hyphens

in domain names,

because they are hard to communicate to others.

GoDaddy is a reliable domain registrar, where you

can explore the possibilities (they even help you with

suggestions). Remember, you are signing up to have

a public name on the Internet for a period of one

year. You pay $10 per year for dot-com and dot-net

domains. Do not buy anything else at GoDaddy (they

will tempt you at checkout with additional web

services). Save all paperwork and write down all

passwords—you’ll need them later. Beware, there

are unscrupulous web registrars/hosts. Use

GoDaddy and be safe.

Web Host: 
I’ve found 3ix.org (www

.3ix.org/one_dollar_web

_hosting.php) to be the best

value in Web hosting. Their

“Excite” service costs $12 per

year (click the 3ix link at the

right to see all the features included). You must

know the domain name registered at GoDaddy when

you order 3ix service. 3ix sends you important e-mail

with default passwords and important IP and name-

server information. Save this paperwork too. At 3ix,

you host on highly reliable Apache servers, another

open source product. Apache runs more Internet

sites than any other webserver. This sits atop Red

Hat Linux, the ‘Cadillac’ of Linux.

Configuration:
You must now go into your

domain account at GoDaddy

and set the nameserver ad-

dresses to the information sent

from 3ix. On GoDaddy you first

unlock the domain, change the

two nameserver addresses and

then re lock the domain. Re-

member it takes up to two

days for your site information to fully propagate over

the Internet.

Look over web hosting options using the 3ix C

Panel. Feel free to read online help files and setup e-

mail accounts. A very nice thing about 3ix is you can

upload files using an IP address before your site has

propagated across the Internet.

Create an images folder in the public_html

directory using the C Panel or KompoZer. Your

HTML files should be uploaded only into the public_

html directory. KompoZer has a handy built-in

publish utility where you set this information.

Practice with one file till you get the transfer config-

ured correctly. Only then upload the whole site. You

must use upper and lower case letters properly in

file names (I find it easiest to use only lower case
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letters for all upload files).

See the result on my friend’s Palm Harbor

Crystalaires website: crystalaires.com. This site

used only KompoZer (with added JavaScript), the

domain was registered at GoDaddy and is hosted by

3ix. Total yearly cost is $22.09

There is much more you may do with the 3ix site.

You can run content management, SQL, PHP

services, etc. They even have a free shopping cart so

you can sell online, and you can give away 20 free e-

mail addresses. The FOSS-SIG website

foss.cypressweb .com uses the GoDaddy and 3ix

setup explained here with content-managed open-

source Joomla design. 
Reprinted from the December 2008 issue of Bits and Bytes,

the newsletter of the Tampa Bay Computer Society, FL.

Converting CD-based Music

 to Compressed Audio Files
by Mike Moore

Editor, Bowling Green Area Microcomputer User Group, KY

I
spent the equivalent of two or three days in

January, working a few minutes at a time,

converting all of our CDs to MP3 format. I had

been dreading this project, thinking that it would

take too much time, but it really was not that bad

and the results are going to be worth it. 

A few years ago, I purchased a 400-CD jukebox

type CD player. This device does has the capability

of displaying a short line containing the album’s

title, using a standard PC keyboard, but the process

is complicated with problems. It’s easy to get CDs in

the wrong slot and of course, you can only play them

in the room where you’ve physically situated the

jukebox unit. 

In the past few years, we’ve been getting away

from the album and becoming more focused on

individual songs. This lamentable trend has been

fueled by the 99 cent price point associated with

downloading music by the song. Artists and produc-

ers alike have vilified this process, claiming that the

artistic sum worth of songs on an album is greater

than the tunes taken as individual songs. 

I can buy into this sadness, to a point. I remem-

ber the smell of vinyl LPs, unwrapping the cello-

phane outer wrap, and the incredible detail the

producers went into in packing artistic value into

the finished product, right down to the order the

songs appear on the album. These days, you just

Google the album or artist title and download the

Jpeg, that’s about it. For a fee, a program called

iTunes will do this for you automatically. 

So why would a guy spend the time to rip (com-

press) the tracks of a CD or other ancient audio

product to MP3 files? There are a few good reasons

to do this. 

For one thing, the devices that play music have

become decentralized. What I mean by that is if. you

can imagine your computer as the “record player,”

then it’s not much of a stretch to think of playing

music anywhere in the house, car or workplace. 

Doing this in the past meant locating the song

you want (which mayor may not be an easy task),

finding the CD (or tape, or LP) it’s recorded on, and

hoping that it’s not damaged. 

Then once you’ve got it, you carry it to where ever

you want to hear it. For me, this was often the car,

and a car is a great place to scratch or otherwise

ruin a CD, and I’ve also known friends whose entire

CD collections have been stolen from vehicles.

Physically moving music and other files from player

to player is sometimes humorously referred to as

“Sneaker Net.” 

But once you begin to think of your songs and

other media in terms of compressed MP3 files, they

become at once more searchable, more replaceable,

and more portable. 

Compressed audio files, though the wonder of a

shared internet database called Gracenote (formerly

CDDB), contain informational tidbits that can

searched. On the other hand, ordinary music tracks

on a Compact Disc have no information associated

with them at all, not even the name of the song. By

converting CD-ROM music to MP3 files, your data-

base can pull up a play list for you using information

encoded in the MP3 file. Most ripping software (such

as C-Dex, available at http://cdexos.sourceforge

.netJ) will query the CDDB so that you won’t have to

manually type in the names of the songs or the

name of the CD. 

Compressed audio files can be stored on any hard

drive in the house and can be made available on

inexpensive MP3 players, iPods, and Multimedia

computers that attach directly to your sound system.

There is usually no special hardware to buy—you

can just feed the stereo output from your computer’s

sound card to the audio input on your TV or stereo

amplifier. 

Most of the MP3 player devices out there do not

require a lot in the way of software—you generally

plug them into a computer, they assign themselves

a drive letter, and you can just copy your songs to

the devices as if they were another hard drive. There

are even self-contained wireless hard drives (see:
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http://www.apple.comlairportexpress) that will

broadcast your music wirelessly to any networked

computer in the house! 

Compressed audio files cannot get scratched like

CDs do, and if your iPod or MP3 player is stolen or

accidentally formatted (happens all the time!), or

even if your entire CD collection is stolen, it’s no

longer the end of the world. You just re-copy the files

back to another device and you’re good to go. 

Though not exactly small, compressed audio files

do lend themselves much better to e-mail. A typical

MP3 music file is around 3 to 6 megabytes, which is

just under the threshold of being too large to send to

someone using dial-up internet. If both ends of the

connection have high-speed, it’s no problem at all, as

this amount of data can be transmitted by most DSL

and cable internet services in about 10 or 20 sec-

onds. The MP3 compressed format is “lossy” in the

sense that some of the music data is lost during

compression, compared to the original recording,

however I’ve never been able to tell the difference

between a compressed song and a non-compressed

track on a CD. The data you lose is not data that

manifests as part of the music. 

By the way, the songs as recorded on CDs you

buy are very large - 50 to 80 megabytes would not be

uncommon. For those of you audiophiles who need

compression but don’t want any data loss, consider

using the FLAC mode of compression (See

http://flac.sourceforge.net for information). FLAC

stands for “Free Lossless Audio Codec.” 

So, there are a host of reasons why we would

want to compress our audio collection, but what is

the downside? The only problem I can think of is

that most automotive and older CD players cannot

recognize the MP3 or any computer generated music

format. Some of the newer CD players can, but it’s

not something that people generally know. So, for

example, when I transferred an audio book selection

to CD for my wife, she found that the CD player in

her car refused to play the media, even though her

car is not that old. MY car, a Chevy Monte Carlo,

played the disk without a problem even though it’s

an older car than hers. So in this situation you may

want to take advantage of software that does the

reverse of ripping—it would take MP3 files and lay

them down on the CD as if they were ordinary Audio

CD tracks. iTunes and many CD-writing utilities

such as Nero will do this for you. 

Now does anyone wanna buy a used 400-CD

jukebox player? 
Obtained from APCUG with the author’s permission for

publication by APCUG member groups. The author may be

reached at www.bgamug .org;ml .moore@insightbb.com 

Tips from Smart Computing
T View Classic Start Menu in Vista: To get back to

a more recognizable Start menu, right-click an

open space on the Taskbar, select Properties,

click the Start Menu tab, select the Classic Start

Menu radio button, and then click Apply. For a

little more control over what appears in the Start

menu, click the Customize button to add or

remove items. Click OK when you’re finished.

T Affordable Smartphones: Even consumers with a

limited budget can afford a smartphone, thanks

in part to new low-cost smartphone offers from

many carriers and manufacturers that offer a

pleasant array of features. These smartphones

often have the basic functions you’d expect,

including phone, e-mail, Web, contacts, calendar,

and task-management capabilities. 

Sometimes you’ll find an older, more full-

featured smartphone offered at a tremendous

discount. These phones can also be great options

for consumers who don’t want to pay for the

latest and greatest phones but still want a decent

amount of power and functionality.

T Go Beyond Point And Shoot: You don’t have to

have a high-powered camera to improve your

photographs. At the very least, adjust White

Balance settings according to lighting conditions.

Even if you use a flash, ambient light will affect

the background of your image, so set the white

balance to tungsten when the scene is lit by

regular light bulbs and Fluorescent for fluores-

cent bulbs, for example. 
Reprinted with permission from Smart Computing. Visit

www.SmartComputing.com/Groups to learn what Smart

Computing can do for you and your user group!

Better Web Searching Tips
by Laura Leita

ICON PC User Group, on Long Island, NY

Find More, Faster, On The Internet

W
ith so much information out there on the

Web, it’s often amazing to discover just how

hard it is to find something you are looking

for, and how easy it is to find things you have no

interest in. I remember once when I was in school

going to the school librarian to ask for books on

Zimbabwe for a report. She came back to me and

told me she did have some books on something

called the Zamanian cockroach. Apparently it was

close enough in the alphabet that she thought it was

good enough but in fact it was way off. This same

thing can happen on the web if you don’t phrase
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your search in the most efficient manner. The

following tips work best with Google, which is my

search engine of choice. 

1. Commas–separate your search with commas. If

you are trying to search for a particular doctor for

example, in a certain city, town, or state, you

would be best to separate the name from the

location with commas. For Example: Joe Smith
Dr, Stony Brook NY. Google actually has a

directory service of sorts and if there is a direct

match with a business it will come up with a

miniature map, the business address, and phone

number right at the top of your search findings.

This is very handy. 

2. Quotes–If you want to search for something ex-

actly as written, put quotes around it. For exam-

ple, if you search for song lyrics, Love me tender
without quotes, you will see searches for Love,
Love me, Love me tender, tender love and many

more variations on those three words. Now if you

put it in quotes, “Love me tender”, it will only

return searches with exactly that match and I am

willing to bet you that Elvis Presley’s famous

song will be right up there near the top easy to

find. 

3. Don’t spell everything out - Words like street,
drive, doctor, avenue, company etc ... can often be

shortened or left out of the search. Try leaving

them off or using the shortened abbreviation if

you are not finding what you are searching for.

The reason is that you do not know how a person

or thing will be listed on the web. The American
Oil Company is most likely listed as Amoco but

could also be listed as American Oil, without the

company added at the end. Just like an address

could be listed as 123 Maple St. OR 123 Maple
Street If you are searching for “123 Maple Street”
in quotes and the address is listed as just 123

Maple St., you might not find it because searches

inside quotes are to be taken EXACTLY as

written. Also a name like Joseph could be Joe or

just J. 

4. Hierarchy of search–Sometimes it is best to start

with all the details you know and then slowly

start pulling details out of the search step by step

until you get a possible hit, getting vaguer and

vaguer in your search criteria. Let’s say you need

to find the phone number for a Doctor Joseph

Smith at 123 Maple Street in Stony Brook, New

York. Below is the order I would recommend

searching in until you end up with a positive

match. Of course hopefully it will come up right

away but you never know. 

a. Joseph Smith MD, 123 Maple St, Stony Brook

    NY 

b. Joseph Smith, 123 Maple, Stony Brook, NY 

c. Dr Smith, Maple St, Stony Brook

d. Dr J Smith, New York (Here you would get too

many Doctor Smiths so I recommend putting in at

least part of the name.) 

e. Dr Smith, Stony Brook, NY 

5. Ask a question–Sometimes you might need to find a

how to, or an explanation. Don’t be afraid to pose a

question: How do You Fly a Kite? What is a White
Hole? How do Clocks work? There are some great

sites out there with lessons on just about anything.

6. Eliminate words–If you know there is a word you do

NOT want to come up in your search you can put a

minus (-) sign before the word and it will not show

any results that match your search and contain that

word. 

Some exercises you can do: Try these searches both

ways and see the difference. Through trial and error

you will soon be able to find anything that is out

there. 

1. Compare these two: 

a. Dr Narula Stony Brook 

b. Dr Harmeet Narula, Stony Brook NY (notice

the mini-map and directory listing right on

top!) 

2. How do you tie those darn things anyway? 

a. Neckties 

b. How do you tie a tie? (tutorial there for you

right on top!) 

3. To use quotation marks or not? 

a. I will follow you 

b. “I will follow you” 

There are many other techniques to learn as you

go. The key is to search efficiently and to save as

much time as possible. Keep an eye out for more

Google tips! 
From the September, 2008 issue of ICON Graphic, newslet-

ter of the ICON PC User Group on Long Island, NY. Laura Leita
is on the Executive Board and serves as ICON’s Secretary. 

Free Computer Help
The location for free online computer support and

computer related information. Computer Hope has

been designed to assist all types of computer users

with any of their computer related questions as well

as a great location to learn more about your

computer and its hardware and software.

 http://www.computerhope.com/oh.htm
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.If Your Computer Gets Wet…

What?
by Bob Schwartz

Houston Area League of PC Users, TX

W
hat to do if something wet spills on your

electronic device or it falls into wet what-

ever? The following is not guaranteed but

represents years of experience.

Quick, unplug it! Unless there is a likely shock

hazard. Look up the instructions (best to do this

when you buy it). Find out if there is any prohibition

against using ALCOHOL. Alcohol can dissolve some

materials.

There are generally two items to have handy.

One is distilled water to first wash off and dilute any

spill, especially anything that might be conductive.

The second is alcohol, 90+% isopropyl (rubbing)

alcohol. Ethyl alcohol or ethanol – 90% – will work

too. Alcohol has an affinity for water. Rinsing the

item first with the distilled water and then with

alcohol will dilute, pick up water, carry it away, and

evaporate quickly. The higher percent alcohol 90%

vs 50% have a greater affinity for water.

Time is important. You do not want water to soak

into an otherwise insulating medium, especially

water that contains something conductive like salt.

It will leave a conductive residue that will short out

portions of the device. That is why you want to rinse

first with distilled water to carry away any conduc-

tive residue and then the alcohol to remove the

water film. Most tap water has dissolved minerals

that remain after the water evaporates, hence the

distilled water to rinse these away.

After, and I repeat AFTER, the above cleaning,

you can use very modest heat to help dry out the

item. You can use a hair dryer at some distance.

Make sure you don’t heat the item any hotter than

is comfortable to hold. Some plastic materials

deform at relatively low temperatures.

Remember the order: (1) rinse with distilled

water (2) rinse with alcohol (3) warm gently with

hair dryer or warming oven.

For items immersed in flood waters, the above

approach can be tried but the outlook is not promis-

ing. Generally the conductive flood waters have had

time to soak into the various insulating materials

and are almost impossible to remove. Still, it may be

worth a try, especially if you have the time and

possible success is worth the effort. Distilled water

and alcohol are not very expensive. Most circuit

boards are coated with varnish to resist moisture. In

this case, wash repeatedly with distilled water. Use

a soft brush to remove any remaining film such as

mud. Then, the alcohol followed by the dryer. Using

the dryer prematurely can “set” the offending

material to the point that it may be almost unremov-

able. So save it for the very last step after you are

sure things are clean. Your efforts may save part if

not all of the equipment.
From the January 2009 issue of  HAL-PC Magazine,

newsletter of the Houston Area League of PC Users. Bob
Schwartz is a HAL-PC member, retired EE, 14 patents, techni-
cal writer, and active in civic affairs. Contact him at
bobx@hal-pc.org.

From The DealsGuy
by Bob (The Cheapskate) Click

Greater Orlando Computer Users Group

They Said It Couldn’t Be Done

H
ave you ever wondered what goes on behind

the scenes when a company sheds one of its

holdings? When the separation between

Daimler’s and Chrysler’s financial systems needed

to happen, many said that would not be achieved for

years, but one guy decided the experts were wrong

and accomplished wonders. Read this fascinating

story at: 

<http://www.informationweek.com/news/show

Article.jhtml?articleID=211200970>.

Here’s an article about what some schools are

doing to gather data that would help improve the

students chances for getting the most out of school.

It’s lengthy, but is at:

<http://www.informationweek.com/news/business

_intelligence/showArticle.jhtml?articleID=2116002

06&pgno=1&queryText=&isPrev=>. Some letters to

the editor printed later were also interesting from

folks that said that teachers also should share the

responsibility for a good education for students.

Just a reminder about the special offer for Dis-

keeper that is still good. <http://www.diskeeper

.com/purchase/purchase.aspx> Also, I have not tried

any of the products below except TeamViewer.

Reminder:

I’ve been using TaxAct to do my income tax for a

few years now and I’m happy with it, although I do

use the pay version because it brings data forward

from last year to edit and the free version doesn’t;

you must type in all the data again. The free version

also does one free E-file for you, and if there’s a

refund, you’ll get it back in ten days. Visit

<http://www.taxact.com>.
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DVD Converter At No Cost
DVDVideoSoft Ltd. has updated their Free Video

to Flash Converter:

With Free Video to Flash Converter it is very

easy to enrich a corporate web site or a personal blog

with a good looking video. The program offers over

80 different themes for the flash player. Free Video

to Flash Converter converts video files, one by one,

or several files at once, to flash (SWF and FLV). Do

the whole movie or just a portion in order to make a

required video.

The updated Free Video to Flash Converter has

a completely new player that meets all up-to-date

standards and has all necessary features. Among

them are:

- full screen mode;

- volume control;

- autoload enable/disable feature;

- autoplay enable/disable feature;

- loop playback;

- big play button on the video;

- play list;

- subtitles support;

- hot keys support.

Free Video to Flash Converter’s design is somewhat

strict, but the colors of all player elements are

customizable. Now everyone can find the matching

one for the particular site. The application runs

under both XP and Vista; very convenient for the

majority of users.

Free Video to Flash Converter is available at

<ht tp : / /www.dvdv ideoso f t . c om / f r ee -dvd -

video-software.htm> for immediate free download.

The program contains no spyware or adware and no

activation or registration is required.

Now For A New Task Manager
AnVir Software has released AnVir Task Man-

ager Pro 5.4, a complete application that lets you

control everything that’s going on while using your

computer. AnVir Task Manager manages startup

programs and active processes and removes spyware

while offering a great variety of Windows enhance-

ments. No need to install dozens of system utilities.

You need only one program instead; AnVir Task

Manager.

This Task Manager replacement analyzes every-

thing that’s currently active on your system and

displays it on a tabbed interface.áIt displays pro-

grams that are scheduled to run upon Windows

start, as well as all active processes, and services. It

shows full information about each process including

command line, its DLLs in use, inbound and out-

bound traffic, disk load, tray icon, performance

graph, and Internet connections.

AnVir Task Manager monitors the system’s

workload, dropping icons in the system tray that

indicate CPU usage (including a breakdown by

application), hard drive temperature, free space,

disk activity (again with per-application info), laptop

battery, memory, and network inbound and out-

bound traffic. You always know exactly what’s

loading your PC’s processing power.

AnVir Task Manager automatically provides a

security risk rating for each active process, service

and startup program. The security risk rating

indicates the likelihood of a program being potential

spyware, malware or a Trojan. The rating is based

on behavior, code analysis, and integrated database

with information about 70,000+ startup programs,

Internet Explorer toolbars and services. When any

program tries to add itself to startup, AnVir Task

Manager shows a notification and enables you to

cancel each new startup program you consider

useless or harmful. Right click on any suspicious

process or file and check it on virustotal .com with

30 antivirus products.

AnVir Task Manager makes using XP or Vista

much handier. With it you can minimize selected

application windows to the system tray to save

taskbar space. You can make windows semi- trans-

parent, or pin them always on top by just

right-clicking on the title of any running application.

Also, you get the list of recently used folders in

Open/Save dialogs. On Windows XP it shows the

drive’s free space with a colored horizontal bar in

Windows My Computer.

AnVir Task Manager offers a very useful

Tweaker that gives you direct access to many Win-

dows settings, enabling you to make your operating

system behave the way you want. Tweaker also

includes many settings that cannot be accessed in

Windows at all without directly editing the registry.

AnVir Task Manager dramatically accelerates your

PC or Windows boot process. The Startup tab shows

all programs that run on Windows start. It includes

name, file path, company, and description. You can

disable or delete programs that you don’t need and

your PC will run much faster.

With its Delayed Startup feature, you can set up

any startup program to load one or more minutes

later after Windows startup. This allows you to

begin using the computer without waiting for Win-

dows to load all startup applications. Also, you can

run startup programs as minimized to system tray,
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or as floating icons.

AnVir Task Manager runs on Windows

XP/Vista/2003/2008 and is available in Pro version

for $59.95, standard version for $39.95 and a free

version, which still has a lot of functions. Users

Group members get 15% discount from the retail

price using the coupon code user group. You won’t

see that on their Web site. 20-days evaluation trial

is available free from <www.anvir.com>.

Take Control Remotely
Having someone talk you through fixing a prob-

lem on your computer doesn’t always accomplish the

task very well, besides taking a lot of time. Perhaps

a better solution would be for the other person to

take control of your machine and physically do the

job before your very eyes, which sometimes happens

when you call a company’s tech support. This could

also be a better system for a helper to teach you how

to use your software to accomplish a special task.

 <http://www.Teamviewer.com> might be the an-

swer for this, and the product is free.

Hewie Poplock <http://www.hewie.net> of Cen-

tral Florida Computer Society told me he tried this

and it works well. Both parties need the product on

their computer, but only one actually needs it

installed for a session. The other can simply run it

without actually installing it. Check their Web site

for more information. In fact, he set up a session

with my machine, although on the first try, I acci-

dentally had control of his machine, so we had to

start over, but the connection was easy. According to

their Web site, we could have exchanged control, but

we didn’t realize that. He checked some settings on

my machine and then I asked him to actually trans-

fer a file from my floppy drive to his machine. While

I could watch him moving the curser around to

check my settings, I was surprised that I couldn’t

see it when he did the file transfer and he didn’t

know a way to make it show up for me, but he also

transferred a jpeg of a document to my machine. If

your file is too large for an e-mail, this method

would do the file transfer quickly and easily.

That’s it for this month. I’ll have some more new

product announcements on my Web site that didn’t

offer discounts. Meet me here again next month if

your editor permits. This column is written to make

user group members aware of special offers or

freebies I have found or arranged, and my comments

should not be interpreted to encourage, or discour-

age, the purchase of any products, no matter how

enthused I might sound. Bob (The Cheapskate) Click

<bobclick at bellsouth dot net>. Visit my Web site at

<http://www.dealsguy .com>

Partition Change: Acronis Disk Director

Suite 10
by George Walker

Houston Area League of PC Users, TX

A “Swiss Army Knife” for Hard Drives.

W
hen it comes to “oper-

ating” on your hard

drive you want a pro-

gram that you can trust. In the

case of hard drives you usually

don’t have time to get a second

opinion. Acronis Disk Director

is a program that you can

trust to modify partitions and

recover deleted or lost parti-

tions.

Acronis Disk DirectorFirst

this is not a program that you will use everyday or

even every month. However, when you do need it

you will be glad to have it in your toolbox. The suite

contains programs that have been tested and proven

to work. You can find various versions of these

programs around that might work on your operating

system and might not. It is generally not the time to

become a Beta tester of software.

Disk Director operates under Windows NT4, 98, ME,

2000, XP and Vista. It will perform operations on

Hard Drives also attached to the computer via USB

and Firewire.

Some of the things that you can do with Disk

Manager hard drive operations are:

* Changing the size of partitions on the drive.

* Creating new partitions so that another operating

system or storage space can be added to the drive.

* Changing the Drives partition formats.

* Adding a Boot Manager so that the desired operat-

ing system is selected at start up. You can use this

boot manager even if you already have one installed

for Windows Systems. It’s easy to add and remove.

* Editing using the Hex Editor. Every once in a

while you may want to look at and sometimes

change the information stored on the hard drive and

you need a Hex editor. It’s right here.

* Recovering lost Partitions and their data.

I have used this with success when it was pack-

aged as a stand-alone program. For this test I wrote

zeros to the location on the hard drive that con-

tained the Master Boot Record and the Partition

Table. The program displays the found partitions as

it progresses. This may take a while, but there is a
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progress bar to let you know that things are happen-

ing. The recovery was a 100% success.

The operations should be clear to all users re-

gardless of experience. For example a partition can

be resized with a few mouse clicks. Highlight the

partition and select “resize” and select the desired

results. The process will complete when you click on

the Starter Flag in the menu bar. An extensive user

manual is available on the Acronis web site in PDF

format.

After you have purchased the software and

installed it on your computer, create a bootable CD

using “Bootable Media Builder” for the event of some

type of hard drive failure. You will have access.

More information on the software and updates as

well as purchase at www.acronis.com/ or User Group

Relations at www.ugr.com/ for less than $50.
From the January 2009 issue of HAL-PC Magazine, newslet-

ter of the Houston Area League of PC Users. George Walker is
a HAL-PC member and volunteer, helping in both “Build or Buy
a Computer” and “PC Upgrade & Troubleshooting” SIGs. After
joining the PC revolution during the CP/M era, he continues to
build, use and fix computers. Contact him at gwalk@hal-pc.org

Is It Possible to Have

 Too Many Fonts?
by Don Edrington

The Senior Computer Tutor

M
ary Hansen wrote that an MSWorks error mes-

sage said she had too many fonts on her computer,

and asked how to delete any unnecessary ones.

Well, I agree that we could dispense with about 90%

of of our fonts. To see what a particular font looks

like go to Start>Control Panel, choose Fonts and

then double-click a font.

Instead of actually deleting any fonts, I recom-

mend moving them into a separate folder, thus

making it possible to restore any that might some-

day be needed.

Right-click your Desktop, choose New Folder, and

name it something like “Surplus Alphabets.” Then

drag unwanted fonts into this folder from the

“Fonts” folder. Note that the dragged fonts are

copied rather than moved, meaning they will need to

be DELETED from the Fonts folder. Conversely,

however, dragging a font from “Alphabets” back into

the Fonts folder will physically move it.

When naming the surplus folder avoid the words

“font” or “fonts” because doing so messes up some

versions of Windows, since Fonts is a “reserved

system folder” name.

Do NOT delete any fonts with a red “A” or any-

thing else in their icons that is red. These are “sys-

tem” fonts. Their removal can play havoc with

Windows.

You should definitely keep on hand the most

popular fonts used on the Internet and by the

average user, such as Arial (ABC abc 123), Verdana

(ABC abc 123), Georgia (ABC abc 123), Comic Sans

MS (ABC abc 123), Times New Roman (ABC abc

123), and Courier New (ABC abc 123).

Courier New is the PC equivalent of the mono-

spaced alphabet used on typewriters for many

decades. (Does anyone remember typewriters?) It

comes in handy for arranging data in columns that

are established by using your spacebar to go from

one column to the next.

Times New Roman is the default font in most

word processors and in many e-mail programs. My

favorite for just plain legibility is Verdana.

Fancy Fonts in E-mail
Bear in mind that fancy fonts will NOT be prop-

erly displayed in outgoing e-mails unless recipients

have the identical fonts on their computers. Other-

wise, the fancy fonts will change to a recipient’s

default; usually Times New Roman.

Changing the Default Font in Certain Programs
You can choose a different default font in some

programs. In Word-2007 under Home click Font,

make your choice and then click the Default button.

In other versions of Word click Format>Font, choose

your favorite, click Default and click OK.

In Outlook Express and Windows Mail click Tools>

Options>Compose and choose a font.

In Notepad click on Format>Font.

In Outlook-2003 go to Tools>Options>Mail

Format>Stationery & Fonts>Font.

In Outlook-2007 go to Tools>Options>Signatures

& Stationery>Font.

Most word processing programs will let you

choose sizes beyond the standard choices. For

instance you can choose 13 points by clicking on any

standard size (say 12 points), mouse-selecting it, and

then typing 13 over it. Some will even let you type in

sizes such as 13.5.

A nifty “Font Explorer” program that lets you

quickly display fonts in many sizes can be freely

downloaded at www.karenware.com.

Information on downloading and e-mailing fonts can

be found http://www.pcdon.com/052508Downloading

E-mailingAndInstallingFonts.html.

PPS E-mail Attachment Won’t Open
John Warner wrote to ask why he couldn’t open

an email attachment that had a file name with a
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.pps extension. I hear this question often, since a lot

of PowerPoint Shows (presentations) are being sent

around. 

A PowerPoint presentation is basically a collec-

tion of pictures that are displayed as a slide

show—often complete with text, animations, and

background music. Someone viewing the show

usually changes slides with a mouse click, but a

presentation can be programmed to change automat-

ically every so-many seconds. Here’s one of my

favorites: VanGogh.pps Here’s another:

NaturalArt.pps 

The program normally used to create such slide

shows is PowerPoint, which comes with most ver-

sions of Microsoft Office. However, Power Point-

compatible programs are freely available from

OpenOffice.org and Google Docs Presentations. 

For simply watching presentations a free Power-

Point Viewer can be downloaded from Microsoft.com.

With any of the above programs in place, a .pps file

should automatically start playing by double-

clicking the file name. 

If the file doesn’t open with a double-click do this:

launch PowerPoint (or a PP-compatible program)

and click FileOpen. Then browse to the target .pps

file and double-click it. 

If the presentation doesn’t begin playing auto-

matically, click on Slide ShowView Show. To exit a

show right-click the screen and choose End Show. 

Creating and/or Editing PowerPoint

Presentations
A PPS file can be made editable by changing its

extension to PPT. When done editing, change it back

to PPS. You can NOT edit a presentation with

Microsoft’s PowerPoint Viewer, but can with the

other programs mentioned. 

Beyond editing, creating your own slide shows is

relatively easy and can be lots of fun. More informa-

tion can be found here: PowerPoint for Beginners 

Reminder 
Everyone needs to be aware of a deadly virus that

has recently invaded the Internet. “AntiVirus 2009"

is NOT an anti-virus program; it is a vicious trojan

that is so destructive most of its victims have to

reformat their hard drives. 

People are tricked into downloading it when a

popup claims it to be a free anti-virus program. It is

so insidious that one’s legitimate anti-virus program

cannot protect against it once a download has begun.

Beyond avoiding this particular threat, make it

a point NOT to download anything from the Internet

of which you are not 100% sure. Anything down-

loaded from a popup is likely, at its most benign, to

contain adware or spyware. At its worst, it can be a

destructive virus. 

Beware of “Free Scan” Ads 
Be aware of ads offering a “free scan” of your PC’s

system registry (or any other part of your computer).

You will be told the scan found problems in your

registry that can be fixed for $40 to $50. If you

decline, you’ll be assaulted by “nag” ads that can

only be removed by—guess what—paying $40 to

$50. 

Another scam is an alleged “Consumer Reports”

type of site that purports to review all the various

“registry cleaner” programs found online. However,

the site has been secretly created by the authors of

one of those programs—the one with the highest

rating, not surprisingly. 

Information on a legitimate free registry scan

and repair by Microsoft can be found here:

http://onecare.live.com/site/en-us/default.htm?redir

=true. 
Don’s home page can be found at http://www.pcdon

.com/index.html. His newsletter is free.

Society News

President’s Column
by Steve Staub

T
his is the toughest column I have written so

far. In December the club lost two members.

In separate ways they contributed a lot to the

club. The first member is David Hassett. Dave was

a quiet man. He always had questions for Help’s

Half Hour. When he could he also had suggestions

for solving someone else’s problems.

Our second member who passed away is Tom

Thompson. Tom was our software procurement

specialist. He would contact software manu-fac-

turers and try to get them to give us software to

evaluate. He also brought to our attention several

excellent ideas. His best idea was at our yearly

picnic have a silent auction instead of a flea market.

This was a huge success thanks to the effort he put

into it. 

Tom’s family requested donations to the Boy

Scouts of America in lieu of flowers. At the January

business meeting I asked the board of director’s to

send a check to the Boy Scouts in Tom’s memory and

they agreed. Boy Scouts of America, 474 East Ave-

nue, Rochester NY 14607.

To the David Hassett and Tom Thompson fami-

lies our deepest sympathy.
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December Planning Meeting
by Sharah Blankenship, Secretary

S
teve Staub led the Planning meeting held at

Sally Springett’s house, January 4th. Others in

attendance were Bob Avery, Tony Dellelo,

Mike Lavelle, Sharah Blankenship, and Dan

Rothfuss. The December meeting was discussed and

it was generally agreed that while it went well, it

would be prudent to do “Double Jeopardy” in the

future so that the meeting will be full length. The

questions for December’s Jeopardy were good, but

there were some technical difficulties that created

problems. Hopefully some of these kinks can be

worked out for next years event. 

The February meeting will take place at the Brigh-

ton Library, but please be advised that it may begin

late. We hope to start the meeting at 6:30, but the

group using the room before us may go until 7. The

March and April meetings will both begin at 6:30

and be held at the Brighton Library. Any one who

wishes to is encouraged to bring goodies. Programs

ideas and presenters are needed for both the March

and April meetings. If anyone has a suggestion or is

willing to present, please contact Mike Lavelle.

The Rochester Computer Society is in need of a new

Software Chairman. Anyone interested in this

position should talk to Steve Staub.

Also, to prevent some of the worry of last year’s

picnic meeting, the lodge is being reserved very

early this year. It is our hope that this action will

help make the picnic more fun for all. We are at-

tempting to gain a lodge in the Brighton Park.

Details to follow closer to the event.

Sadly, there have been a few deaths in the club

since the December meeting. Tom Thompson, the

Software chairman and board member, passed away

on December 22, 2008. In honor of his memory and

his service to RCSi, the club has decided to donate to

the charity of his family’s choice, The Boys Scouts of

America. We also grieve the loss of our member,

Dave Hassett, who passed away December 18th

2008.

The mailing software issue for the club has been

resolved. A new program was chosen for the mailing

software, and it seems to be less expensive, less of a

hassle, and better serviced. 

Please bring goodies to the February meeting if you

would like to! Happy Valentines Day!

Help’s Half Hour
Tuesday, January 13, 2009

Led by: Arpad Kovacs

Recorded by Jan Rothfuss

Q: A member is receiving e-mails correctly. One

particular newsletter is coming through as gibber-

ish. He would like to try other styles. No success.

A: Try going into preferences, view settings and

select plain text rather than html.

Q: He has an XP machine that has had a root

directory failure. 

A: It might be the boot.ini file. Try entering the

short commands to reestablish. There may be a bad

sector on the hard drive. Another option may be to

download the hard drive’s vendor software. It will

attempt to read each sector and tell you if the drive

has any problems. Gibson Research site may have a

program, too.

Q: Has anyone tried Windows 7?

A: Yes, it looks like KDE (a Linux desktop). The file

system is FTFS. It does crash a lot but this is a beta

version. It is supposed to be faster than Vista. If you

buy a new machine now, it will include a free up-

grade when it is available. All drivers are supposed

to be there. It is quite a bit leaner so that less

overhead is loaded.

Q: One member bought a Vista Home Premiun

machine. Is there a good fax program to add?

A: WinFax will not work. Try going to FreeWare

Files.com and search for the Vista OS. MajorGeeks

.com and SnapFiles.com may be other possibilities.

Q: One has a DVD-RW that no longer allows further

adds.

A: Perhaps there is now a scratch. If the second burn

fails, you will lose the first items, too. There may be

a data recovery tool in the freeware sites listed

above.

Q: Does anyone have a suggestion for an audio

recording software?

A: Audacity is a free product that should help there.

Q: One member has a couple of photo programs that

have come with his cameras. He has tried to delete

the Cannon software. When he tries to remove the

Cannon and use Kodak EasyShare, he gets a mes-

sage that neither program is available. 

A: Windows has a feature to view/copy photos using

the card reader. SyncToy is recommended for cutting

and pasting files. It has better recovery and will

continue the process rather than fail and prompt

you to start again. 

Q: What is the equivalent of MS Config for XP?

A: Go to a command box and type in MS Config.
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Home Premium and Home Basic Vista have it as

well. If XP fails, there may be a virus. Do a search

for the file.

Q: A member has AVG that has not been updated

recently. He gets an error message.

A: He may have to start up the safe mode. Be sure

that it is coming from your virus program. There is

a virus that displays a similar message. They can

even simulate a crash. It was also suggested that

you change your theme color from blue. That way

you could see whether the message box is real.

Q: Has anyone used Nero Wave editor?

A: No one as of yet.

The Lighter Side
Help Desk: “How can I help you?”

Employee: “I need my left-handed mouse.”

Help Desk: “I’m sorry, we don’t have special mice for

left or right hands.”

Employee: “The mouse at the old building was left-

handed, and I need one of those.”

After much discussion, a technician was sent out to

the employee’s cubicle. Upon his return....

Help Desk: “Did you fix her issue?”

Technician: “Yeah.”

Help Desk: “What was it?”

Technician: “I took out the mouseball, rotated it 180

degrees, and put it back in. It made her happy.”

While working telephone technical support at an

ISP, I took a call from a woman who said her mouse

was acting “strange.” I had her do a few things and

determined that her right and left mouse buttons

appeared to be swapped. But when I had her check

the settings, they were normal.

Her husband, who had previously owned a

computer store, checked it out and couldn’t figure

out what was wrong, either. So they brought it in for

service.

When I tried it out, everything worked fine, so I

had her come in and demonstrate the problem.

When I asked her to right-click, she left- clicked.

When I asked her to left-click, she right-clicked.

It took several more minutes to convince her to

use her “other left.” She protested that she had a

college degree and knew left from right. 

On two occasions I have been asked [by members

of Parliament!], ‘Pray, Mr. Babbage, if you put into

the machine wrong figures, will the right answers

come out?’ I am not able to rightly apprehend the

kind of confusion of ideas that could provoke such a

question.

–Charles Babbage, 1792-1871

Computers can now keep a man’s every trans-

gression recorded in a permanent memory bank,

duplicating with complex programming and intricate

wiring a feat his wife handles quite well without

fuss or fanfare.

–Lane Olinghouse

As the trials of life continue to take their toll,

remember that there is always a future in Computer

Maintenance.

–National Lampoon, from “Deteriorata”

Part of the inhumanity of the computer is that,

once it is competently programmed and working

smoothly, it is completely honest.

–Isaac Asimov, 1920-1992

The computer is the most extraordinary of man’s

technological clothing; it’s an extension of our

central nervous system. Beside it, the wheel is a

mere hula-hoop.

–Marshall McLuhan, 1911-1980


